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USER GUIDE TO THE CROSSWALK SOFTWARE 

 
SYSTEM REQUIREMENTS – WINDOWS 95 OR BETTER 

Note:  Windows2000, WindowsNT, or WindowsXP Operating Systems 
Require Administrative Rights 

 
KNOW YOUR FILES 
 
• Write down the name and path where your files are stored. 
• The layout of all files must be in columns in the following order:  Fund, 

Function, Object, and Dollar Amount. 
• There should be 2 separate files - one for revenues and one for 

expenditures. 
• Your files can be called anything you wish as long as you can distinguish 

between your revenue file and your expenditure file.  
• Text files require record layout locations, so you will need to know the 

beginning location of each column and column length (in characters) for 
both the revenue and expenditure files. 

 
GENERAL INFORMATION 
 
It is not always necessary for Crosswalk users to download and install a full 
version of the Crosswalk software.  Installing a Full version of the software 
is only necessary when there are major updates or completely new processes 
developed for the Crosswalk software.  These modifications do not happen 
every year.  In most cases, Current Crosswalk users can use a short cut 
method to setup and begin processing their NPEFS data.  (Refer to the 
“Short-Cut Method” section below for step-by-step instructions.) 
 
 

A Highlights page is developed each year, when applicable, that lists new 
features and enhancements for the new processing year.  We strive to 
continually produce a better software product each year to make the NPEFS 
Crosswalk software one of the leading options available for NPEFS data 
submission. 
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Features Introduced in FY02 
 

• Duplicate record entry eliminated for fund/function/object.  
Provides up to 10 warnings of record duplication and then suggests 
that the entire file is probably a duplicate and forces the user to re-
evaluate the dataset. 

 
• Single records “delete” option.  This feature allows for easy deletion 

of one or several data records without having to delete the entire 
revenue or expenditure data set. 

 
• Full feature search mechanism.  This feature allows for the filtering 

of funds, functions, and objects to aid in identifying individual or 
group records and their corresponding dollar values. 

 
Features Introduced in FY03 
 

• An additional report (Load Duplicates) was added to the software that 
holds all duplicate data records that have the same fund, function, 
and object.  With this report, the user will be able to evaluate the 
flagged records for possible adjustment and inclusion into the 
dataset.  (The possibility does exist for a state to have the same 
fund/function/object record with a different dollar amount.)   

 
• A “Frequently Asked Questions” section has been added to this 

manual for FY03.  This is an increasingly popular method of finding 
answers to commonly asked questions.  The FAQ section is very 
beneficial and we are confident it will substantially reduce phone/e-
mail requests for help. 

 

• “Understanding the allocation process” is another section that we have 
added for FY03.  More respondents are asking more questions on how 
data distributions are setup and activated.  The allocation process 
requires multiple tables to produce the desired result.  This section 
delves into each table’s structure and explains its layout and 
usefulness in distributing combined data into more than one function 
object category. 
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• The “Allocation Prep Program” was developed to safeguard against 

errors in setting up allocation tables.  It includes descriptive error 
message boxes for help in resolving errors as well as status boxes to 
remind you of errors (or to ensure you that allocations ran without 
incident).  

 
Features Introduced in FY04 
 
• Version 4.5 of the Crosswalk software now includes a transfer to 

server option located in the software interface on the main menu bar 
under FILE.  The feature allows the respondents to transfer their 
translated data submission to the Census Web server without any 
intervention from NPEFS staff.  The respondent can then seamlessly 
access the Census Bureau’s Web site from the Crosswalk Hyperlink 
box that appears after clicking transfer to server. 

 

• Online editing is now available for all NPEFS respondents for FY04.  
Previously Crosswalk respondents may only access their data online to 
sign-off on the digital confirmation process.  Now with online editing, 
Crosswalk respondents will view, explain data differences, and 
troubleshoot data anomalies before submitting their data.  The 
process will drastically cut down on time-consuming error solution e-
mails and notes between respondent and NPEFS staff.  Detailed 
instructions for online editing processes are available at:  
http://www.census.gov/govs/www/npefs.html. 

 

• Crosswalk respondents still must FTP their state databases to the 
Crosswalk staff via the Census Web site.  If for any reason a 
respondent is unable to transfer their data via the Crosswalk 
software, the NPEFS staff will complete the transfer. 

 

• The Crosswalk software has been upgraded to accommodate the new 
special exhibit items for instruction.  They are:  1) salaries paid to 
teachers in regular education programs, 2) salaries paid to special 
education teachers, 3) salaries paid to vocational education teachers, 
4) salaries paid to teachers in other programs providing instruction, 
and 5) textbook expenditures for classroom expenditures. 
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SET-UP PROCEDURES FOR CURRENT CROSSWALK 

USERS 

(Short-Cut Method) 
 

The downloadable Crosswalk software setup executable and state data files 
can be obtained from the NPEFS Website  
(http://www.census.gov/govs/www/npefs.html). 
 

1) Create a new directory within “c:\Program Files” using the standard 
naming convention (e.g., “xwalk98_FYxx” – replacing “xx” with the 
correct two digit fiscal year.   For FY2004 data, replace “xx” with 
“04”). 

 

2) Download the latest executable file (.exe) and related program file 
(.mdb) from the NPEFS Website to this new directory.  The location 
of these files will be clearly marked within the Crosswalk section of 
the main NPEFS website page.  

 

3) Download “your state’s data” from the NPEFS Website.  The location 
of the data will be clearly marked (under a drop down menu named 
“State Data Files”) within the Crosswalk section of the main NPEFS 
Website page.  If your state’s data is not available, the database will 
not be found.  (Your state’s data includes an important translation 
table that converts state data into proper federal format). 

 
Once these three procedures are complete, processing may begin. 
 
New crosswalk respondents or current respondents running an older version 
of the Crosswalk software must install the latest version of the Crosswalk 
software.  This process is quick and setup is automatic.  The only drawback 
is that you must have “administrative rights” to complete a successful 
installation of the software with all Windows versions (except Windows95 
and Windows98).  The installation file is also located within the Crosswalk 
section of the main NPEFS Website page.  Detailed installation instructions 
are also available there for your convenience. 
 
Below are the instructions and procedures for preparation of FY04 
processing. 
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SET-UP PROCEDURES FOR NEW CROSSWALK USERS 
 
 
DOWNLOAD THE CROSSWALK SOFTWARE 
 

Listed below are detailed steps for accessing the Census Bureau’s NPEFS 
Web site to download the Crosswalk software and your state-specific 
translation table (referred to as “State Data”). 
 

• Open your Internet browser (Netscape or Microsoft Internet 
Explorer).  In the address area of your toolbar type: 

www.census.gov/govs/www/npefs.html 
 

You are now at the Census Bureau’s NPEFS Web site.  Scroll down the front 
page until you reach the Crosswalk section.  Look for the installation file 
called “Xwalkinstall.exe.” 
 
1) Create a directory in c:\program files\xwalk98_FY04. 
 This will be your target directory. 

 
2) Download the software installation file, “Xwalkinstall.exe” into the target                                          
directory.    

 
a) Select the software installation file link (in the “New Crosswalk 
Users” section towards the bottom of the screen). 

 
 b) A “File Download” box will appear with “Save this program to 

 disk” selected by default.  Select the OK button. 
  
 

 
c) A “Save As” box will appear.  Make sure the file you are 
downloading will be saved in the c:\Program Files\xwalk98_FY04 
directory and then select the Save button.  
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DOWNLOAD AND EXTRACT YOUR STATE DATA FILE 
Note:  This process is for ALL Crosswalk users.  If you have downloaded the Crosswalk 
software and installed it, then the directory the software uses has already been 
created - C:\Program Files\xwalk98_FY04.  If you start with this download before 
the installation download you must create this directory. 
 
To download your state data file into the target directory: 
 

1) From the State Data Files drop down list, select your state (only                                                                                                                                                                                                                       
updated state crosswalks appear in the dropdown menu).                                                                                

 
2) A “File Download” box will appear with “Save this program to disk” 

                 selected by Default.  Select the OK button. 
 

 3) A “Save As” box will appear.  Make sure the file you are  
downloading will be saved in c:\Program Files\xwalk98_FY04 
directory and then select the Save button.       

  
You state’s data file is now downloaded into the target directory as a zipped 
application file within the executable file.  The zipped application file will be 
named “ST04zip.exe” where “ST” is your 2 digit state abbreviation and “04” 
indicates the year.   

 

To automatically extract your state data file:  

1. From Windows Explorer, select the C:\Program Files\xwalk98_FY04 
directory. 

 

2.  Double click on the application file “ST04zip.exe”.  
 
3.  The State data file, “ST_xwalk98.mdb,” will automatically self-
extract. 

 

This completes the installation of the State Data portion of the Crosswalk 
software. 
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Install the Crosswalk Software  
(New Users and Computers that have never had the Crosswalk software installed) 

Important - If your computer is running WindowsNT, Windows2000 or 
WindowsXP, the installer MUST have administrative rights.  If you do not 
have administrative rights, have the Crosswalk software installed by your 
technical support staff.  You should close all other applications before 
attempting to do the following: 
 

To automatically extract the files needed to install the software:  

1. From Windows Explorer select the c:\Program Files\xwalk98_FY04 
directory. 
 

2. Double click on the application file, “Xwalkinstall.exe.” 
 

A Windows box will appear with the following message: 
 
You are about to decompress and install the Crosswalk software.  
Please refer to the “Installation Instructions” for more 
information. 

 

3. Select the Setup button. The Setup application will start to copy the 
files. 
 

You may (or may not) get the system message below:  (if you do not 
get this message skip to item #11) 
 
Setup cannot continue because some system files are out of date 
on your system. Click ok if you would like setup to update these 
files for you now. You will need to restart Windows before you can 
run setup again. Click cancel to exit setup without updating system 
files. 
 

4.  Select the OK button. 
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5.  Setup may or may not ask the following:  

Do you want to restart Windows now? If you choose 'No' you will not 
be able to run setup again until after the system is rebooted at a later 
time. 

6. Choose Yes. 
 

7. Your system will now automatically reboot. 
 

8. After the system has successfully rebooted, return to the 
c:\Program Files\xwalk98_FY04 directory. 
 

9. Double click on the application file “Xwalkinstall.exe”. 

A Windows box will appear with the following message: 

You are about to decompress and install the Crosswalk software.  
Please refer to the “Installation Instructions” for more information. 
 

10.  Select the Setup button.  The setup application will again start 
copying files, this time successfully. 
 

11. The following message will appear: Setup cannot continue unless all of 
your applications are closed. 
 

12.  Choose OK to continue Setup. 
 

13.  By default, Crosswalk Setup will install the software in c:\Program 
Files\xwalk98_FY04. 
      

14.  Click on the Computer button to install the Crosswalk software. 
 Crosswalk - choose program group screen will appear.  Click the  
 Continue button. 

15.  An “Installing Data Access Components” box will appear and it will  
 automatically install Microsoft Data Access Components 2.1. 
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16.  You may (or may not) get one or more “Version Conflict” boxes 
stating: 
 
 A file being copied is older than the file currently on your system. 
 It is recommended that you keep your existing file..,etc. 
 Do you want to keep this file? 
 
 ALWAYS respond, “YES” to this question. 
 

17.  Eventually you will get a message stating that Crosswalk setup is 
complete. 
 

This completes the installation process for the Crosswalk software. 

Double click on the “Xwalk98.exe” file within the target directory and begin.  
You may also select the software from the START button on the Windows 
task bar and navigating through the various applications on your computer). 
 
 
 

LOAD YOUR DATA 
 

All four Load Data options have been upgraded to safeguard against 
entering duplicate data records.  The following example shows the “Load 
Warning” message box for duplicate data in an Excel spreadsheet.  Similar 
load warnings are provided for the other three load options.  The only 
difference between the various load-warning boxes will be, of course, the 
corresponding data type (i.e., text, database, Excel spreadsheet or single 
record load).  
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Caution: If you are loading a file and duplicate records are found, you will be 
shown a warning box on the 10th duplicate record suggesting that the entire 
file may be duplicated.  By clicking OK after the 10th record you will be 
exited from the loading process and returned to the main screen of the 
Crosswalk application.  If the entire file is not a duplicate, remember that all 
records that were not duplicates were loaded before reaching the 10th 
record warning box.  Refer to the Load Duplicates report (under Reports 
from the main menu bar) for a complete log of all duplicate records. 
 
 
 

 
 
 
Begin Loading: 
 

Open the Xwalk98 program by double clicking on the application file 
“Xwalk98.exe” (with the tiger paw icon) in the C:\Program Files\xwalk 
98_FY04 directory or from the START button on the Windows task bar. 
 

It does not matter whether you load revenues or expenditures first.  
 

1. Within the program, choose File from the main menu bar (the bar under 
the title “Crosswalk – Revenues” or “Crosswalk - Expenditures”).  

  
2. From the drop-down menu choose Toggle Rev/Exp.  Each time you click 

on this selection the application toggles back and forth between revenues 
(Fig. 1) expenditures (Fig. 2).  Notice that the title bar changes from 
“Crosswalk - Revenues” to “Crosswalk - Expenditures” (focus on the very 
top border). 
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   Fig.1 

   
 

 

Fig. 2 

 
  
  
  
 
 
3. If you are loading a text file, choose File>Enter State Data format 

from the drop-down menu (Fig. 3). 
 

(If you are loading data from a Microsoft Excel spreadsheet, skip to page 
17.  If you are loading data from a Microsoft Access database table, skip 
to page 19).    
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Fig. 3 

     
 
 

      Note:  Text files are the only files that require record layout locations.  
If you try loading a revenue data text file without completing the record 
layout locations, you will be prompted by the following error message:  
Please complete the State Data Format for Revenues before Loading 
Data.  If you were loading expenditure data, the statement would be 
similar except, obviously, reference would be made to expenditures 
rather than revenues. 

 
 

Fig. 3A 
  

   
 

4.  Fill in each item (Fig. 4) in accordance with the record layout of your 
file.  Enter the beginning column and its length.  Tab between entries.  
This procedure is identical for both the Revenues and Expenditures 
screens.  Again, use Toggle Rev/Exp under the File menu of the main 
screen to switch between revenue and expenditure data.  
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 Note:  There are two areas that indicate what type of data you are 
entering--the title bar and the record layout window.  There should 
be no confusion as to where you are in the process. 

 
 
 

Fig. 4 
  

  
 
 
 
 
5.  Within the record layout window click on the File menu in the upper 
  left corner and select Exit to leave the record layout window.    
  

 

6. To load your data choose File from the main menu bar.  From the drop 
down menu, choose Load Data.  The following window appears (Fig. 5): 
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Fig. 5 
 

Text File Example 
 

    
 
 
 
 

7. You will have four choices to load your data— 

1) Text File  

2) Microsoft Access Table (*.mdb) 

3) Microsoft Excel Spreadsheet (*.xls) 

4) Single Record Load 
 

 
 

If your File is a text file (the default selection as shown in Fig. 5 above), 
click OK.  Otherwise, select your file type by clicking the appropriate 
option.  Then click OK. 
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The following window (Fig. 6) appears: 
 
 
 

Fig. 6 

Text File Example 
 

 

 
 
 
 

 

8. Notice that, by default, “*.txt” appears in the Enter File Criteria 
prompt box (if your text file has another extension change it in this 
box).  This indicates you chose to load a text file.  Directly below 
“*.txt” in the Select Data File prompt box is the letter denoting your 
current hard drive location (default to c:\).   Access the drive where 
you saved the Crosswalk program and your state data file(s) (this will 
probably be the c:\ drive.  Below the drive selection is a field that will 
show the directory paths indicating where you saved the Crosswalk                           
program and your data files.  Fig. 6 illustrates that our files are saved 
under C:\Program Files\xwalk98_FY04.  The Select Data File 
window will show all files in the Enter File Criteria window (in this 
case, *.xls).  Fig. 6 shows that no text files exist in the C:\Program 
Files\xwalk98_FY04 directory.  
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Figure 7 (below) illustrates which Excel spreadsheet files reside in our 
c:\Program Files\xwalk98_FY04 directory (since the extension “*.xls” 
appears in the Enter File Criteria window). 
 
 
 

Fig. 7 
Excel Spreadsheet Example 

 
 

  
 

 
Highlight the name of the file you wish to load from the listing of files in 
the Select Data File window.  Click OK.  The following prompt appears: 
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Fig. 7A 

   

   
 
 
The program defaults to “Sheet1”.  Refer to the Excel spreadsheet 
example below (Fig. 7B).  As you can see on the tabs at the bottom of the 
spreadsheet below, “Sheet1” is the default name for the first sheet of 
an Excel worksheet.  You will need to change the worksheet name in the 
Enter Worksheet Name prompt box (Fig. 7A) if the data you wish to load 
is not on a sheet titled, “Sheet1”. 
 
Fig. 7B 
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Figure 8 (below) illustrates which Access database files reside in our 
C:\Program Files\xwalk98_FY04 directory (since the extension “*.mdb” 
appears in the Enter File Criteria window). 
 
 
 

Microsoft Database Example 
Fig. 8 

   
 
 
 
 
9. Highlight the name of the file you wish to load from the listing of   

files in the Select Data File window.  Click OK.  Fig. 9 shows an          
example of loading a table from an Access database file.  Click on the      
down arrow in the Select Table window.  A drop-down menu appears, 
which displays all the tables in the database file.  Choose the table 
with your state data and click OK. 
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Fig. 9 
 

   
 

 
 
 

10. After loading your revenue (or expenditure) data, a message box (Fig. 
10) appears confirms the successful load by displaying “Revenue Load 
Complete” (or “Expenditure Load Complete” in the case of 
expenditures).  

 
Fig. 10 
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Note:  You have the option of loading data more than once.   This is a very 
convenient option if your data are located in multiple directories or files.  As 
long as the data are in the expected format (fund, function, object, amount) 
you can continue to load state data files until all files from all sources are 
loaded.  Example:  Suppose you have state revenue data files located into 
more than one file.  You can append the additional revenue data files by 
selecting Load Data from the File menu on the main screen (if necessary, 
first use the Toggle Rev/Exp selection to switch to revenue data).  After 
your initial successful data load, a message box appears stating, “Revenue 
Load Complete” (Fig. 10).  To append additional revenue data to your initial 
data load, select Load Data again.  A message box will appear stating, “State 
Revenue Data Already Loaded – Do you want to load additional items?” (Fig. 
11).  Choose Yes.  The additional data will be appended to the data you loaded 
previously. 
 
 
Fig. 11 
 

   

 
 
11.  Figure 11a (page 22) illustrates the Single Record Load feature.    
 

This option is ideal for single records you wish to load without having to 
append the records to an existing data file.  You may want to use this 
feature for Title I and Title V data entries.  Enter the data in the proper 
format of fund, function, object and dollar amount by tabbing through 
the entries.  Note that the Amount field is automatically formatted with 
commas once you press the Enter key.   Click on the Save button when 
you are finished.   
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IMPORTANT  
 
Please be aware of the types of data items you are loading (see Fig. 11b 
below).  It is important to note that it is possible to load an expenditure 
record within a revenue table (and vice-versa) if you are not paying close 
attention to the title bar, which indicates whether you are loading 
“Revenues” or “Expenditures.”   
 
 

Fig. 11a 
 

  

 
After the Save button is pressed, a message box appears stating that the 
data was loaded successfully.  It will say either, “Revenue Record Load 
Complete” or “Expenditure Record Load Complete” (depending on which data 
type was loaded).   
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Fig. 11b 
 

  
 
The load feature closes after you click OK acknowledging the 
“Expenditure/Revenue Record Load Complete” message box.  You will not be 
prompted to load another single record. You must go through the process of 
selecting File>Load Data>Single Record Load each time you want to load a 
single record.   

 
Translate 
 
Translate is the fifth item on the main menu bar.  It refers to the 
procedure that converts state codes (in fund, function, and object form) 
into codes that correspond to cells on the National Public Education 
Financial Survey (NPEFS) form and adhere to the Financial Accounting for 
Local and State School Systems, 2003 Edition.  Translate Data is the 
only option under the Translate menu.  The amount of time it takes to  
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translate the state data to H2R2 codes varies according to how many 
records there are to be translated.  If allocations are required it will take 
even longer.  During the translation process, there will be a flashing 
indicator (varying in color) indicating which part of the process is taking 
place:  1) Translating Revenues, 2) Translating Expenditures, or 3) Allocating 
Expenditures.  As indicated the process first translates revenues, then 
expenditures, and finally allocates revenues and/or expenditures (if 
allocations are needed). 
 

Fig. 12 

 
  
 

Fig. 13 

 
 
 
                                                                                     
Fig. 14 

 
 
 
Note:  If you need to rerun the translation, just select Translate Data 
again.  Each translation will override the previous translation. 
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Transfer to Server 
 

Version 4.5 of the Crosswalk software now includes a transfer to server 
option (Fig. 11c) located on the main menu bar under File.  This feature 
allows the respondent to transfer their translated data submission to the 
Census Web server.   Online editing processes have been incorporated into 
the Web application beginning with the FY04 data collection making it 
necessary for respondent control of getting the completed data file to the 
NPEFS Web application.  Starting with this year’s (FY04) data collection, 
edit checks have been integrated into the NPEFS Web application, making it 
necessary for the respondent to transfer their NPEFS data to the Census 
Bureau’s server.  After transferring their data to the Census server, 
respondents can begin the new editing process, which includes correcting (or 
explaining) possible data errors, before final submission of data. 
 
This new editing process necessitated the development of a smooth process 
for data transfer and upload to the Census server.  Below are the steps for 
transferring translated state data from the Crosswalk application to the 
NPEFS web application. 
 

1) Select Transfer to Server from the File menu. 
2) Click the Census Bureau link provided in the message prompt box. 
3) Select Web Form. 
4) Enter the 8-character password provided by the NPEFS staff.  

This will initiate the upload process, after which final editing of 
your data can begin. 

 
 Fig. 11c 
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Allocations 
 
An allocation distributes one single state data item among multiple Federal 
functions and objects.   
 
Allocations are often necessary because many states have categories that 
are combined.   A good example of combined data is employee benefit 
amounts.  Often states are not able to report this data by category 
(instruction, support services, food, etc.) because they only have one lump 
sum amount.   An allocation could be set up to distribute this combined 
amount into appropriate function/object categories.  
 
For a more detailed discussion of allocations and its processes, refer to the 
sections on Allocation Status Message Boxes (page 28) and also see the 
Understanding the Allocation Process section (page 54). 
 
To Translate your data, follow these procedures: 
 
1. Select Translate from the main menu bar and Translate Data from the 

drop-down menu.   
 
 
Fig. 16 
 

    
 
2. Click Yes to the message box that appears, asking, “Are you sure you 

want to translate state data?” (Fig. 17). 
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Fig.17 
 

   
 
 

3. Enter your ADA (Average Daily Attendance) as defined by state law or 
NCES, (whichever method pertains to your state). (Fig. 18).  Press the 
Enter button after each entry.   

 
Fig. 18 
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4. The “translation” process has now begun.  When the translation is 
complete, several message boxes appear in sequence.  The first message 
box states either “no unmatched data records” or “the number of 
unmatched data records” (see Fig. 19 and Fig. 20 for examples).  The 
second message box states “the number of data exclusions present” (Fig. 
20a), and the third message box states the status of the allocation 
process (“allocations are complete”) (Fig. 20b).   

 
                                   

Fig. 19 

   
 

Fig. 20  
 

   
 
 
Matched/Unmatched Data Records Message Box 
 
Data troubleshooting may be required if you have unmatched data records.  
Unmatched data records occur when there is a state data record 
(fund/function/object/amount) that does not have a translation record to 
direct the state record to the Federal category (function/object) it 
represents.   
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To view your unmatched data records, choose Reports>Errors from the main 
menu bar.  The errors could be revenues, expenditures, or a combination of 
both.  You may have to toggle between revenues and expenditures to locate 
all of the errors.  For more explanation on the Errors report, see the 
“Errors” sub-section of this user guide (page 40). 
  
Data Exclusions Message Box  
 
Data Exclusions are data records that have not been aggregated to any 
category on the NPEFS form.  Records are accumulated and presented in 
report display for review.  These exclusions are usually by design but 
sometimes exclusions can mistakenly occur.  It is highly recommended that 
this report be thoroughly examined for accuracy and corrections made to 
misdirected records.  You can access this report from the main menu bar 
under REPORTS>Data Exclusions.  For more explanation on the Data 
Exclusions report, see the “Data Exclusions” sub-section of this user guide 
(page 42). 
 

 Fig. 20a 
 

 
 
 

Allocation Status Message Boxes 

 
The process of allocating data is an important part of the Crosswalk 
software.  This process is invoked when there is a state data record amount 
earmarked for more than one Federal function/object category.  The 
software is equipped to distribute percentages to those multiple categories 
through a complex process involving relationships between many Access 
tables and databases.   



Crosswalk User Guide 
      

31 

 
If your state has no allocations, the only flashing indicators during the 
translation process will be “Translating Revenues” and “Translating 
Expenditures.”  The Allocation Status message box will appear at the end of 
all message boxes after translation even if your state doesn’t have 
allocations.   
 
For more explanation on the Allocation process, refer to the sub-section 
“Understanding the Allocation Process” of this user guide (page 54). 
 
 
 

 Fig. 20b 
 

 
 
 

Allocation Error Message Boxes 
 

There are several allocation error message boxes to warn against incomplete 
setup of allocation tables.  Allocation tables are always initially developed 
and set up by the Crosswalk staff (in conjunction with state respondents).  
However, respondents are welcomed and encouraged to perform annual 
maintenance of their state’s allocation tables.  Allocations can and often 
change from year-to-year.  Some allocations are dropped while other are 
added careful and complete manipulation of allocation table records must be 
practiced.  To avoid allocation problems from incomplete or inaccurate table 
setup, an Allocation Prep Program was instituted.  This program has  
 
 
alleviated any possibility of unknown unallocated data records.  For more 
discussion on the Allocation Prep Program, refer to the sub-section 
“Allocation Prep Program” of this user guide (page 64). 
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Edit State Data 
 

The Edit menu on the main menu bar (Fig. 21) gives the user the option of 
deleting single or entire state data records.    
 

1. Choose File from the main menu bar. 
2. From the drop-down menu, select the type of data you would 

like to delete (revenue or expenditure) with the Toggle 
Rev/Exp option. 

3. After you’ve selected the type of data you want to delete, go 
back to the main menu bar and click Edit (Fig. 20).  

 
 

Fig. 21 
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Delete State Data 
 

You may want to delete all of your data records from the software.  Maybe 
you were testing your input file, loaded your state data into the software 
program, and for whatever reason, now want that data removed.  
Fortunately, the Crosswalk software gives you the option of removing the 
data as quickly as you loaded it.  Be aware, however, that you can only delete 
the entire data set for the data type indicated along the title bar of the top 
of the Crosswalk software.  If, for example, the title bar indicates 
“revenues” (Fig.  22), then only the revenue records will be deleted.  
 
From the main menu bar choose Edit. From the drop-down menu in Edit 
there are two choices:  Delete State Data and Delete Single Record (see 
Fig. 21 above).   Choose Delete State Data.  If you’ve chosen to delete 
revenue data, the following warning screen appears (Fig. 22): 
 
 
 
 

Fig. 22 

    
 
 
 
Click YES and your State Revenue Data (or expenditure data if you are 
deleting expenditures) will be deleted from the software.  Click NO to 
retain the data as you loaded it.   Note:  The same procedure applies for 
deleting expenditure data.   
 
 
 
 
 
 



Crosswalk User Guide 
      

34 

 
If you had already deleted your state’s data, and try to delete it again, the 
following screen appears (in the case of revenue data): 
 
Fig. 22a 

 
 
 
 

Note:  A similar statement (referring to expenditures) would appear if you 
were trying to delete previously deleted expenditure data. 
 

 
Delete Single Record 
 
 

If you want to delete a single record, select Edit from the main menu bar 
and select Delete Single Record from the dropdown menu.   You will then be 
prompted for the fund, function, and object of the record you want to 
delete.  Enter the appropriate information and click the Delete button at 
the bottom of the “Single Record Delete” prompt box.  If you wish to exit 
this selection, without making any changes, choose File, then Exit from the 
upper left corner of the prompt box. 
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Fig. 22b 

  
 
 

Single Record Delete Error 
 
If the single record entered does not match any of the records loaded into 
the Crosswalk system, you will receive an error message (Fig. 22c) stating, 
“Nothing to Delete!!! No record found matching the Fund, Function, and 
Object you specified.  Select OK and you will be taken back to the Single 
Record Delete prompt box to re-enter the correct information. 
 
 

Fig. 22c 
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Single Record Delete Confirmation 
 
After all of the data fields are entered correctly press the Delete button.  
You are then asked to confirm deletion of the keyed revenue (or 
expenditure) record (Fig. 22d).  Click Yes to confirm deletion.  
 
 
Fig. 22d 
 
 
 
 
 
 
 
 

 
 
 
If you choose Yes, a prompt box appears, confirming that the record was 
deleted (Fig. 22e).  The exact deletion confirmation statement would 
obviously depend on the data type being deleted. 
 
Fig. 22e 
 
 
 
 
 
 
 
 
 
 

 
If you choose No you are taken back to the “Single Record Delete” prompt 
box.  You can then either enter data information for a new record or exit by 
choosing File>Exit from the upper left corner of the “Single Record Delete” 
prompt box.  
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If you click Delete while in the “Single Record Delete” prompt box without 
entering any record data you will receive a “Single Record Delete Warning” 
message box stating that the “Fund, Function, and Object cannot be blank!” 
(Fig. 22f).  Click OK to return back to the “Single Record Delete” prompt 
box so that you can either enter the correct record data to delete or exit 
from the box altogether by selecting File>Exit from the upper left corner 
of the “Single Record Delete” prompt box. 
 
Fig. 22f 

 
 
 
 

Search 
 
 
A Search feature is located on the main menu bar.   This search feature is 
available to filter through funds, functions, and/or objects and helps you 
quickly isolate individual (or a subset of) records and their corresponding 
dollar values (see Fig. 23b below).   You can view and print the entire loaded 
data set by selecting State Data from the Reports menu.   
 
 

Fig. 23a 
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Here (in Figure 23b) we have the Search mechanism that displays the 
entire revenue data set.  Notice that the data type shown in the title bar 
of the Crosswalk application (above the main menu bar) is “Revenues”.  
“Revenues” is also shown in the title bar of the “State Data Search” 
prompt box itself.  Likewise,  if the data type were “Expenditures,” 
(instead of “Revenues”) these same areas would indicate that data type. 
 
The default setting for each fund, function, and object is “Every Record.”  
Each of the dropdown menus provides the opportunity to view all of the 
records within that selection.  For this example, we have only two 
revenue records (as referenced at the bottom left corner of the 
“Search” box).  Move through each page or the beginning and end of the 
entire data set using navigation arrows located in the bottom center of 
the “Search” box.  You can exit the Search feature by pressing the EXIT 
button at the bottom right corner of the “Search” box or by pressing the 
X in the upper right hand corner of the same box. 

 
Fig. 23b 
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REPORTS 
 

The Crosswalk software contains 11 reports to help you review your data.  
They are:  
 

1. State Data 
2. Load Duplicates 
3. Errors 
4. Translation Table 
5. Prior Yr./Current Yr. 
6. Data Exclusions 
7. State to H2R2 Link 
8. NPEFS Certification 
9. NPEFS Revenues 
10. NPEFS Expenditures I 
11. NPEFS Expenditures II 

 
Viewing of the reports before and after translating your state data. 
You can view the “State Data” report before translating the data because 
this is merely an exhibit of your loaded state data.  Your translation table is 
also always available.  You can view your prior year data before “translating” 
your current year data by opening the “Prior Yr/Current Yr. report.”  If you 
open report 9, (NPEFS Revenues) 10, (NPEFS Expenditures I) or 11 (NPEFS 
Expenditures II) before translating your data, they will all show zeros in the 
amount columns (since the data has not yet been translated to the item 
codes). 
 
Generally, revenue reports are displayed separately from expenditure 
reports.  Look at the title bar of the Crosswalk application before choosing a 
report to view.  If it reads “Crosswalk – Revenues” the software is set to 
read the revenue reports.  If you want to view expenditure reports, click on 
File in the main menu bar and then click on Toggle Rev/Exp to switch to 
expenditure data.  The “Prior Yr/Current Yr" and "Data Exclusions" reports 
do not change by data type.  They are presented as one combined report.  
Both of these reports list all revenue data first, then expenditures.  You can 
go directly to these reports without having to toggle between revenues and 
expenditures.   To exit any of the reports, click on the X in the upper right 
corner of the report window or click on the red paw icon in the upper left 
corner of the report window and select Close from the drop-down menu. 
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You can export any of the following reports to File by clicking on the disk 
icon in the upper left hand corner of the report window: State Data, Errors, 
Data Exclusions, Translation File, Prior Yr/Current Yr, State to H2R2 Link.   
You can also print any report by clicking on the printer icon.  Note: The 
NPEFS Certification, NPEFS Revenues, etc. reports can only print one page 
at a time.  A “Print page” icon appears on each page of the report.  Simply 
click this icon on each page you want to print.   
 

 Fig. 24 
 
 

 
 
 

1.  State Data 
 
The “State Data” report displays your state data as it was loaded into the 
Crosswalk application (Fig. 25).  There are 5 columns for each account code, 
indicating type of data loaded, (revenues or expenditures) fund, function, 
object and amount. 
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Fig. 25 
 

 
 
 
 
 

2. Load Duplicates 
 

The “Load Duplicates” report displays a list of duplicate load records (see 
Fig. 25a below).  We have provided the standard information to identify 
the duplicate record data type (revenue or expenditure), fund, function, 
object, and dollar amount.  Also displayed are the date (and time) of the 
load attempt, along with the file name and whether the data loaded was in 
table or spreadsheet format.  This additional information should help you 
identify multiple duplicate data entries from the same file name.   
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Fig. 25a 

 
 
 

3. Errors  
 
The “Errors” report displays one of two messages after the translation and 
allocation processes have completed:  a list of unmatched data records (Fig. 
26) or a prompt box stating “No Error Data to View” (Fig. 27).  Unmatched 
data records are records in your state data for which there are no 
corresponding records in your state’s translation table (the translation table 
directs specific state account codea to our standardize Federal account 
codes and places the aggregate total to the corresponding category).  
 
The translation table is the heart of the Crosswalk process.  Keeping the 
translation table up to date is very important.  Annual maintenance of this 
table will help keep the translation process free of errors.  This maintenance 
can be preformed by either the state coordinator or by NPEFS staff 
working with the state coordinator.  Census does require, however, all 
state coordinators keep them abreast of all changes to the translation 
table, indicating the date (in the date stamp column of the “Xlate” 
table) for each record that was last revised.   
 
For assistance from the Census Bureau in resolving any errors, you can 
obtain contact information by choosing HELP>Contacts from the main menu 
bar. 
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Fig. 26 
 

 

Fig. 27 

   
 
 
4. Data Exclusions   
  
The “Data Exclusions” report is a list of extraneous state data records that 
are not to be included with the final NPEFS data reported (Fig. 27a).  This 
report should be reviewed carefully to confirm that this data is not to be 
included on the NPEFS report.  This review will also help you to, if needed, 
“re-direct” certain state data items to their appropriate Federal account 
codes (by modifying the translation table).  Finally, this report could serve 
as a troubleshooting tool if a certain category’s aggregated total doesn’t 
match the aggregated total you were expecting.    
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After the translation process is completed, several message boxes will 
appear in a sequence.  There are 3 message boxes, 1) no unmatched data 
records or the number of unmatched data records, 2) no data exclusions or 
the number of data exclusions included, and 3) the announcement that the 
allocation process is completed.  Figure 27a is notifying you of the number of 
data exclusions present and request that you review them for accuracy. To 
access the “Data Exclusions” report, select REPORTS>DATA EXCLUSIONS 
from the main menu bar. 

 
Both revenue and expenditure exclusions are combined into a single report 
(Fig. 27b) so it is not necessary to toggle between revenues and 
expenditures.  Revenues are listed first, followed by expenditures.  

 
Fig. 27a 
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Fig. 27b 

 
 

5. Translation Table 
 
The “Translation Table” report shows the path your data took when it was 
re-coded from your state’s account codes to the standardized H2R2 codes.  
The data are displayed by state codes, (beginning and ending fund, function, 
and object codes respectively) the corresponding Federal Codes, (fund and 
object) as well as the general description of the Federal codes (Fig. 28). 
            
Fig. 28 
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6.  Prior Yr/Current Yr  
 
The “Prior Yr/Current Yr” report displays your state’s prior year data, 
current year data, and the difference between the two - both in dollars and 
as a percentage (Fig. 29).  With the side-by-side comparison of current and 
prior year data, this report can be very helpful in resolving data 
discrepancies in the early stages of data preparation.   
 
 

You do not have to toggle between revenues and expenditures for this 
report.  Both revenues and expenditures are displayed in this report 
(revenues are listed first, then expenditures). 
 

 
 Fig. 29 
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7. State to H2R2 Link 
 

The “State to H2R2 Link” report (Fig. 30 below) displays the amount of 
money in each unique state data record (each represented by a different 
fund, function, and object code) on your state data file and matches it to its 
corresponding category on the NPEFS form represented by “Item Code” and 
“Item Code Descriptions.” 
 
Item Code sorts this table in order so that you can quickly view all of the 
“like” Item Code dollar amounts together.  The aggregate total for each 
Item Code will be the amount displayed for the corresponding item category 
on your state’s final NPEFS form.    

 
There are two separate reports for revenue and expenditure data.  You must 
toggle between revenues and expenditures (FILE>Toggle Rev/Exp from the 
main menu bar) to view both reports. 
 
 
Fig. 30 
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8.  Certification Page 

 
The “NPEFS Certification” page must be signed by the designated 
authorizing official and submitted no more than 5 business days after 
the NPEFS form has been submitted.  Your submission will not be 
considered official without this certification (for more information, 
please refer to this year’s NPEFS Instruction Booklet). 
 

 
 

Fig. 31 
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Digital Certification 
(This certification constitutes a true and full report of revenues, expenditures, and 
student attendance as stated by the Elementary and Secondary Act of 1965 and as 
amended by the No Child Left Behind Act of 2001.)  

 
Digital certification is a relatively new process that allows the NPEFS 
designated authorizing official to electronically sign off on their NPEFS 
submission.  This new feature will be useful for all NPEFS authorizing 
officials because it is easy to use and has the added dividend of providing an 
electronic return receipt to both the designated authorizer and NPEFS 
staff.  Digital certification is not required, however, the authorizing official 
may still certify the NPEFS submission by paper certificate through the 
mail.  Please see this year’s Instruction Booklet for instructions for paper 
certification in the section entitled, “Instructions for Submitting Fiscal 
Data (Paper and Electronic).” 
 
The digital certification password is a set of 15 characters that is provided 
to the official who certifies the data submission.  This set of characters is 
provided to the authorizer only and should not be given to anyone else so 
as not compromise the integrity of the electronic certification process.  The 
authorizer also receives an 8-character password used for entry into the 
web application (the person preparing the report for the web form also uses 
this password).  
 
The procedure for electronic certification is outlined below:  
 

1) The official enters the 8-character entry password through the 
Census Web application (http://www.census.gov/govs/www.npefs.html)   

2) Perform the on-line editing process, and reviews the data for 
thoroughness and completeness.  

3) Submit the NPEFS report. 
4) Navigate to the “Signature” page.  (The official has the option of 

viewing the completed data, viewing the fiscal data plan, or certifying 
the data submission).   

5) Follow the Signature LINK.   
6) Enter the 15-character password appropriately, and click Submit.   
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You will then receive confirmation of the digital signature and be taken 
back to the password page.  Note:  You will not be able to use the 
digital confirmation application again unless you contact the NPEFS 
staff so that the form can be reset to accept a new signature.  
Contact us by E-mail at govs.npefs@census.gov or by phone at (800) 437-
4196. 

 
9.  NPEFS Revenues 
 
The “NPEFS Revenues” report displays the amount of money in each revenue 
item on the NPEFS form (Fig. 32).  This report, as well as the two 
expenditure reports (10 and 11 below), mimics the NPEFS paper form 
exactly. 
 
Fig. 32 
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10.  NPEFS Expenditures I 
 
The “NPEFS Expenditures I” report displays the amount of money in each 
expenditure item on Part I (Instruction) and Part II (Support Services) of 
the NPEFS form. 
 
11. NPEFS Expenditures II 
 
The “NPEFS Expenditures II” report displays the expenditures in Parts III 
through XV of the NPEFS report as follows: 
 
 

Part III  Operation of Non-Instructional Services 
Part IV  Direct Program Support 
Part V  Current Expenditure 
Part VI Facilities Acquisition and Construction Services 
Part VII Other Uses-Debt Services 
Part VIII Community Services 
Part IX Direct Cost Program 
Part X Property  
Part XI Total Expenditures for Education 
Part XII Exclusions From Current Expenditures for State Per 

Pupil Expenditure (SPPE) 
Part XIII Net Current Expenditure 
Part XIV Average Daily Attendance (ADA) 
Part XV State Per Pupil Expenditure 

 
 
 

For the “Certification,” “Revenues,” “Expenditures I,” and “Expenditures II” 
reports, the panel on the far right displays the state two-digit abbreviation 
and the current fiscal year.  It also contains an EXIT button and a forward 
(right facing) red arrow.  The red arrow allows you to move forward through 
the report one page at a time.  On the following pages, there is also a back 
(left facing) arrow that allows you to navigate previous pages.  Click EXIT to 
leave the report. 
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Print a Report  
 
Follow these steps to print the following reports:   

State Data 
Load Duplicates 
Errors 
Data Exclusions 
Translation File 
Prior Yr/Current Yr 
State to H2R2 Link 

 
 
1. Click on File on the main menu bar.  Click on Toggle Rev/Exp to choose 

the type of data you wish to print (revenues or expenditures).  You do not 
have to toggle between revenues and expenditures for the “Data 
Exclusions” or “Prior Yr/Current Yr” reports. 

 
2. Select a report by clicking on Reports on the main menu bar.  Highlight 

your selection and click on it to open the report. 
 
3. Click on the printer icon in the upper left corner of the window that 

contains the report you selected.  A Windows Print box opens.  You can 
choose to print one, several, or all pages of the report, single or multiple 
copies, and also choose a printer to print the report. 

 
4. Choose the print option you desire and then click on Print to print the 

report. 
 
Follow these steps to print the following reports: 
 
 Certification 
 NPEFS Revenue 
 NPEFS Expenditures I 
 NPEFS Expenditures II 
 
1. Click on Reports on the main menu bar. 
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2. Highlight your selection from the drop down menu and click on it to open. 
 
3. Click on the Print page icon located on the right side of the report just 

below the fiscal year (refer to Fig. 31 above).  This will print the first 
page of the selected report. 

 
4. Repeat step 3 for each page of the report you wish to print.  Use the red 

arrow icon to navigate between the pages.  Select Reports from the main 
menu bar to if you wish to select another report to print. 

 

Export a Report 
 
1. Select a report by clicking on File on the main menu bar.  Click on Toggle 

Rev/Exp to choose revenues or expenditures. 
 
2. Click on the export icon (the icon to the right of the printer icon on the 

left corner of the page).  A dialog box opens.  From there you can choose 
where to save (export) the report and in what format (Figure 33). 

 
Fig. 33 
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View a Report in Larger or Smaller Fonts 
(This section does not apply to the Certification, NPEFS Revenues, NPEFS Expenditures I, or NPEFS 
Expendi tures II reports as these reports do not have Zoom functionality).  
 

1. Select a report data type by clicking on File on the main menu bar.  Click 
on Toggle Rev/Exp to the type of data you wish to look at (revenues or 
expenditures).  From the Reports drop down menu, select the desired 
report. 

 
2. To the right of the export icon, there is a Zoom drop down menu.  Click 

on the down arrow in the window to the right of the word “Zoom.”  You 
can adjust the font size of the report by changing the zoom percentage 
(the higher the percentage, the higher the zoom size). 

 
3. You can view each report page-by-page by using the arrows at the bottom 

of the window.  The outer left and right arrows will move you to the first 
and last record, respectively.  The inner arrows will move you one record 
forward (right) or backward (left).  The scroll bar to the right of the 
report window will move you from the top to the bottom of the current 
page.  Click and hold the left mouse button to drag the scroll bar up or 
down.  To scroll up (or down) one line at a time, click once on the up (or 
down) arrows above (or below) the scroll bar on the right side of the 
screen to move to the next (or previous) line.   

 
 

Help 
 
The items found under “Help” are Contacts and About.   Contact lists the 
Crosswalk application contact name, phone number, fax number, and e-mail 
address (Fig. 35).  About displays the current version of the Crosswalk 
software and brief licensing information (Fig. 34). 
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Fig. 34 

                        
 
 
 
 
 
 

Fig. 35 
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Special Exhibit Items 
 

The processing of the special exhibit items requires unique labeling of state 
records to identify and allow for these items to be included in the 
cumulative state Instruction (Function 1000) total but also as separate 
amounts for special exhibit item display. 
 

Two-letter abbreviations are used to identify the teacher’s salaries and 
textbook expenditure records (refer to Appendix E for the state fund 
legend).  These abbreviations will replace the corresponding state fund for 
each record we wish to include as a special exhibit item.  We will keep the 
function and object of each special exhibit item record the same as they are 
in the original state record so as not to drastically change the identity of 
the record.  This labeling process allows us to easily tabulate the funds, 
which are being broken out into special exhibit items.  (Note:  The sum of 
the special exhibit items should never exceed the total state Instruction 
amount). 
 
Appendix D displays the new special exhibit items, along with the 
corresponding item codes and H2R2 functions and objects.   
 
(Allocations may be required to calculate special exhibit items if records for 
teacher’s salaries and/or textbook expenditures are not broken out within 
the state’s data.  If this is the case, please contact the Crosswalk staff for 
assistance). 
 
Below is an example of state data records for Instruction (along with the 
corresponding translation table layout of those records) for state X.  State 
X knows that three of these records correspond perfectly to certain special 
exhibit items and they can be broken out and translated for exhibit item 
display.  With this data, state X breaks out and displays special exhibit 
items for vocational teacher’s salaries and textbook expenditures.  These 
three records are marked in the State Data Records table below (with 
asterisks). 
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Example:  State X 

 
State Data Records 

(For Instruction-related items) 
 
 Fund  Function Object Amount 
 100  5420  150  50,000 
 100*  5550  151  20,000 
 100  5560  155  25,000 
 100*  5570  160  30,000 
 100  6510  175  75,000 
 100*  6520  110  10,000 
 100  4650  101  15,000 

 
 
    Translation Table 

(For Instruction-related items) 
BegFund EndFund BegFunc EndFunc BegObj EndObj H2R2Func H2R2Obj 

100 100 4650 6520 101 175 1000 100
VE VE 5550 5550 151 151 1003 111
TB TB 6520 6520 110 110 1005 640
VE VE 5570 5570 150 150 1003 111

 
 
 
 

    

  

  

 
 
 
 
 
 
 
 
 
 

In this example, the first record in the Translation Table directs all expenditure 
records within a specified range (fund 100; functions 4650-6520; objects 101-
175) to the H2R2 function and object code for Instruction salaries (function 
1000; object 100).   Also notice, singled out for special exhibit item display are 
two records for (salaries paid to vocational education teachers) and one record 
for (textbook expenditures for instruction).  Notice that the next three records 
in the Translation Table are included within the range specified in the first 
record (meaning these records will be included within the Instruction salaries 
total in the final NPEFS data).  But item codes, (specifically, salaries paid to 
vocational education teachers (VE) and textbook expenditure for instruction (TB)) 
within these records will also be directed to the appropriate special exhibit item 
category. 
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Understanding the Allocation Process 
 

Brief 
Allocations are an integral part of the NPEFS report.  All states (Crosswalk 
and non-Crosswalk) have “combined” data items that must be distributed 
among more than one function and object.  Some of the more common 
problems are: 

 
• Amounts reported as a lump sum and not in their appropriate 

functions. 
• Expenditures reported for employee benefits. 
• Tuition payments to other school districts that cannot be separated 

between in-state and out-of-state. 
 
The method for making these distributions may differ from state to 
state.  However, most states have some type of allocation issue we must 
resolve.  The Crosswalk was designed to make these distributions through 
a systematic process and this design does not differ among states using 
the software.   It is important to note that the methods used to 
crosswalk “problem” data are, in some cases, merely a satisfactory 
solution to the problem, and in others, an interim solution at best.  When 
the problem represents a relatively small amount of money, prorating this 
combined data is usually the most efficient method of distribution.  
When combined data represents a relatively large percentage of 
reported funds, and impacts particularly important functions (such as 
instruction and administrative functions), modifications in state 
accounting systems are usually needed to resolve the problem.   

 
Methodology 
There are several tables in two different databases that work together to 
process allocations.  The main database (Fig. 36a) houses the majority of the 
allocation tables and is presented as “T_xwalk98.mdb”  (where ST refers to 
your two-letter state abbreviation) and is referred to as the State 
database.  The other database houses various tables, (some are used for 
allocations, and some are used as look-up tables), and is saved as 
“xwalk98.mdb” and referred to as the Program Database.   The order in 
which the databases are listed does not reflect the order to which the 
databases are used in the allocation process.  A visual display of all the 
tables involved in the allocation process appears below (Fig. 36).  
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Fig. 36 
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The actual programming portion of the allocation process is complex and the 
allocation process involves complicated relationships between many Access 
tables and databases.  The process is far too technical for general 
understanding and too cumbersome to list its intricate processes.  The 
intent here is simply to provide a general overview of the allocation process 
and to provide a detailed description and function of each of the applicable 
tables. 
 

General Overview of the Allocation Process: 
• When you translate your data there is an interaction between the 

state data (original input file) records you loaded into the software 
and the Xlate table that matches all of your state data records to a 
corresponding federal function and object.  One part of this 
interaction is to locate the records that are to be allocated.  A 
checked box in the “ALLOCATION” column of those records 
determines whether or not allocations will be performed for a 
particular record. 

• The allo-look-up table is built from the Xlate table to show just 
those allocation records.  Each allocation record is given a name 
(referred to the table as an allotype.   

• The ACCTALO table lists the H2R2 function, object, and “ToH2R2” 
object to be distributed as well as the percentage of combined data 
applied.  (Zero is given as a percentage if not known.  The Crosswalk 
software will then determine the allocation percentages through use 
of the build-calculations table (discussed in the user guide). 

• The ALOCATE table lists the order in which allocations will be made.  
• The HISTALO table lists the distributed records by allotype and 

dollar amount applied based on the directive provided in the ACCTALO 
table.  Notice that all of the like allotype records in the HISTALO 
table added together equal 100% (“PCTBASE” column).  Notice that 
the dollar amounts for all like allotype records equal the amounts from 
the STATE DATA (STDATA) table records that required an 
allocation.  Be aware that more than one STATE DATA record can be 
part of an allocation.  Often, several like records are directed (from 
the Xlate table) and assigned the same allotype to make the 
distribution percentages between the like records equal.  (A good 
example of this would be records associated with the employee 
benefits). 
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The common thread “among” each of the allocation tables explained above is 
the allotype (name). 
 
Detailed Makeup of Allocation Tables 
 
 
There are 5 tables in the database below that are used in the allocation 
process.  They are:  ACCTALO, allo-look-up, ALOCATE, H2ACCT and 
HISTALO.  Shown below in (Fig. 36a) is a screen shot of all the tables within 
the STATE DATA (ST_xwalk98.mdb).      

 
Fig. 36a 
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ACCTALO 
 
The ACCTALO table is composed of the following significant columns.   
 

• ST (State) 
• EXPREV (Expenditure/Revenue) 
• FY (Fiscal Year) 
• ALLOTYPE (Allocation Type) 
• H2R2 FUNCT (H2R2 Function) 
• H2R2 OBJ (H2R2 Object) 
• ToH2R2OBJ (TOH2R2 Object) 
• ALLPCT (Allocation Percent) 
 
The primary function of the ACCTALO table is to house all records (along 
with their allocation percentages) that require distribution to more than 
one function and/or object.  The “ALLOTYPE” column is critical in that it 
provides a label to each record that makes it unique.  
 
If a record is to be distributed but a percentage amount is not known a 
“0” will be entered as the allocation percentage for that record.  The 
Crosswalk software is designed to calculate an allocation percentage for 
each record in the ACCTALO table by “building” a calculation-based 
denominator and dividing the aggregate total of like records into that 
denominator.  This is discussed in more detail in the section titled, “Build-
Calculations” (page 63). 
 
 
ALLO-LOOK-UP 
 
The allo-look-up table is composed of the following significant columns:   
 
• ST (State) 
• EXPREV (Expenditure/Revenue) 
• FY (Fiscal Year) 
• STATEFUND (State Fund) 
• STATEFUNCT (State Function) 
• STATEOBJ (State Object) 
• ALLOTYPE (Allocation Type) 
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The primary function of the allo-look-up table is to list all records that 
were checked in the “ALLOCATION” column of the Xlate table (which 
indicates that the record requires an allocation).  The “ALLOTYPE” column in 
the allo-look-up table indicates the name of each record.  This column field 
is a text field, which can hold up to 5 characters.  In naming each record, we 
often use words (or labels) that remind us of the kind of distribution this 
field represents.  For example, we might use the label “EB” if the 
distribution were for employee benefits.  We also use number (1, 2, 3, 001, 
002, 003 etc.) or letters (A, B, C, etc.) to name records.  There is no set way 
to name a record as long as the records name does not exceed 5 characters.   

 
ALOCATE 

 
The ALOCATE table is comprised of the following significant columns:   
 
• ST (State) 
• EXPREV (Expenditure/Revenue) 
• FY (Fiscal Year) 
• ALLOORDER (Allocation Order) 
• ALLOTYPE (Allocation Type) 
• ALLODESC (Allocation Description) 

 
The primary function of the ALOCATE table is to specify the order in 
which allocations are processed.  The order is simply a number assigned to 
each record in ascending order.  You don’t necessarily have to start with the 
number “1”, but whatever number you start with, the next number must be in 
ascending order.  An allocation description field is included if the allotype is 
not descriptive enough for identification purposes.   
 
NOTE:  Changing the order in which the allocations are processed can effect 
how combined data are distributed.  Depending on the relative “weight” 
(dollar amount) of a record, order changes can have a profound effect on 
the final allocation percentages if the same record is used in multiple 
allocations. 
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H2ACCT 
 

The H2ACCT table us composed of the following significant columns:   
 
• EXPREV (Expenditure/Revenue) 
• FY (Fiscal Year) 
• H2R2FUNCT (H2R2 Function) 
• H2R2OBJ (H2R2 Object) 
• DOLLARS  

 
The primary function of the H2ACCT table is to list each state record 
(whether allocated for not) in its corresponding H2R2 format.  This table 
displays aggregate dollar totals of these records (in H2R2 format) and is 
referenced during the allocation process.    
 
Note:  An H2R2 function and/or object is made up of multiple state 
records.   
 

 
The build-calculation process (see the section on the Build-Calculation table 
later in this users guide) produces and applies percentage amounts to the 
aggregated records listed within the H2ACCT table.  The H2R2 dollar 
amounts in the H2ACCT table are not easily traced back to the state dollar 
amounts because the build-calculation process only holds and displays the 
last completed allocation.  Each previous allocation result is cleared to make 
way for the next allocation percentage to be derived. 
 
HISTALO 
 

The HISTALO table is composed of the significant following columns:   
 
• EXPREV (Expenditure/Revenue) 
• FY (Fiscal Year) 
• STATEFUNCT (State Function) 
• STATEOBJ (State Object) 
• ALLOTYPE (Allocation Type) 
• H2R2FUNCT (H2R2 Function) 
• H2R2OBJ (H2R2 Object) 
• TOH2R2OBJ (To H2R2 Object) 
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• DOLALLOED (Dollars Allocated) 
• DENOMINAT (Denominator) 
• PCTBASE (Percentage Base) 

 
The HISTALO table lists the final allocated dollar amounts and how they 
were allocated.   To fully understand the tabulated results of the HISTALO 
table you must also use the ACCTALO table in conjunction.  The common 
thread between these two tables is the ALLOTYPE column.  The ACCTALO 
table directs the records to be distributed to their prospective H2R2 
function and object along with the same ALLOTYPE assignment for each of 
those records and, if known, the percentage amount to be applied to that 
record.  (Note:  If a percentage is not known for that record, then a “0” is 
applied and the software will produce a percentage to be applied to that 
record).    
 
This information is essential to the HISTALO table because this table 
applies the distributed amounts based on the percentages listed in the 
ACCTALO table to those H2R2 functions and objects.  If you group 
together the “like” allotypes, and add together the allocated dollar amounts 
for the records that total 100%, you can trace back the original amount 
listed in the state data (with the assistance of the Xlate table with the 
column marked “ALLOCATION”).   
 
Also notice that the ALOCATIONS table located in the program database 
(xwalk98.mdb) list the aggregated total, by allotype, of the allocated dollars 
found in the HISTALO table.  (The generic database is discussed further 
below.)   
 
Program Database 
 
Shown below in (Fig 36b) is a screen shot of all tables within the program 
database (xwalk98.mdb).   There are 3 tables in the program database below 
that are used in the allocation process:  the ALOCATIONS, BUILD-
CALCULATIONS, and H2RULE tables.  



Crosswalk User Guide 
      

66 

Fig. 36b 

    
 
 
 
The ALOCATIONS table is composed of the following significant columns:   

 
• EXPREV (Expenditure/Revenue) 
• STATEFUND (State Fund) 
• STATEFUNCT (State Function) 
• STATEOBJ (State Object) 
• ALLOTYPE (Allocation Type) 
• ALLOORDER (Allocation Order) 
• DOLLARS  

 
The primary function of the ALOCATIONS table is to list each state record 
to be allocated, along with its corresponding dollar value.  Notice that the 
allotype and alloOrder have also been assigned for each record.  If more 
than one of the same allotype is present, add all like allotypes together for a 
total allocation amount of that allotype.  This table works in conjunction with 
the ACCTALO, ALOCATE, and HISTALO tables in the state database.   
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Build_Calculations 
 
The Build_Calculations table is composed of the following significant 
columns: 
 

• H2R2FUNCT (H2R2 Function) 

• H2R2OBJ (H2R2 Object) 

• TOH2R2OBJ (To H2R2 Object) 

• ITEM_CODE (Item Code) 

• DOLLARS 

 
The Build_Calculations table sums all dollar amounts marked for allocation by 
item code.  This table calculates the percentages that will be applied by 
first adding together all the item code amounts (which forms the 
denominator for this calculation).  Each individual item code amount is then 
divided into this denominator and an allocation percentage for that specific 
item code is determined.  This percentage is then applied to the 
corresponding H2R2Funct and to H2R2Obj record listed in the ACCTALO 
table within the state database.  The results of this calculation can be 
viewed in the HISTALO table (grouped by like allotype). 
 
Note:   

• The Build_Calculations table is used only when percentages to 
distribute data are not known.   

• This table only displays the last group of allocations (as determined by 
the ACCTALO table in the state database).  Allocations are 
performed in order - revenues first, then expenditures.  

• Item codes are assigned to each record by the H2RULE table 
(discussed below).   

 
H2RULE 
 
 

The H2RULE table is composed of the following significant columns:   
 
• EXPREV (Expenditure/Revenue) 
• FY (Fiscal Year) 
• Item_Code (Item Code) 
• DESC (Description) 



Crosswalk User Guide 
      

68 

• BH2R2FUNCT (Beginning H2R2 Function) 
• EH2R2FUNCT (Ending H2R2 Function) 
• BH2R2OBJ (Beginning H2R2 Object) 
• EH2R2OBJ (Ending H2R2 Object) 

 
H2Rule is a static table, which is used only as a “matching” tool for assigning 
item codes (specifically, matching item codes to their corresponding H2R2 
functions and objects).  
 
 
Allocation Prep Program 
 

The Allocation Prep Program was developed to safeguard against errors in 
setting up allocation tables.  Allocation tables are always initially developed 
and set up by the Crosswalk staff (in conjunction with the state respondent). 
However, some respondents perform a yearly “maintenance” of their 
allocation tables, which could include changing allocation percentages, adding 
additional functions (and/or objects) for distribution, and deleting records, 
which are no longer applicable to the NPEFS survey.   Because multiple 
persons are working with these complex allocation tables, it was decided to 
incorporate an allocation checking method within the Crosswalk software.    
 
The allocation prep program runs without notice by the user until a problem 
with the allocation set up is detected or when the translation process is 
complete.  There are four possible warning boxes - two warning boxes each 
for Allotype Mismatch and State Data Allocation errors.  The warnings will 
indicate where the error resides. 
 
The three main allocation tables are located within the state database (Fig. 
36a) and are called ACCTALO, allo-look-up, and ALOCATE.  All three 
tables have a common link – the ALLOTYPE column indicating the name of 
each record.    
 

• The ACCTALO table lists each record (and the percentage to be 
distributed) along with its corresponding H2R2 function and object 
destinations.   

• The allo-look-up table lists all records from the Xlate table that are 
marked for allocation in the Xlate table (indicated by a checked box in 
the “ALLOCATION” column of this table).   The number of records in 
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the allo-look-up table varies depending on how many allocations are to 
be performed.  

• The ALOCATE table lists, in ascending order, (referred to in the 
table as alloOrder) the order in which the allocations are performed.  

 
The error message in Figure 37 (below) is displayed when an Allotype 
Mismatch error is detected.  The allotype assigned to a record in the allo-
look-up table is different or does not exist for the same record in the 
ACCTALO table.  The error message provides the name of the allotype for 
easy error resolution. 
 

 
Fig. 37 

  
 

 
The following error message (Fig. 38) will appear after the Allotype 
Mismatch error box is closed as a reminder that translation is not yet 
complete and shows the number of allotype mismatches to be reviewed. 
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Fig. 38 
 

  
 
 

The error message in Figure 39 (below) is displayed when a State Data 
Allocation error is detected.  Notice the phrase “Translating Expenditures,” 
(in green at the bottom of the screen) indicating that these errors were 
detected during an expenditure allocation.  This error will arise anytime 
there is a conflict with assigning an alloOrder.  The ALOCATE table is 
where the alloOders are assigned.  If there is a conflict or inconsistency 
between the allotypes in the ALOCATE table and the allotypes in the allo-
look-up table then an alloOrder cannot be assigned and the allocation cannot 
be completed.  This problem, however, can be easily and quickly resolved 
since the record(s) in error are provided in the error message box.    
 
 
NOTE:  The error warning in Figure 38 differs from the error warning in 
Figure 37 because the error message in Figure 38 appears during the state 
data translation process, whereas the error message in Figure 37 appears 
before the translation process has begun.  By the time the error message in 
Figure 38 appears, some state data records have already been translated to 
their corresponding H2R2 functions.      
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Fig. 39 

 
 
 
The error message in Figure 40 (below) displays a second type of state data 
allocation error.  Again, notice the phrase “Translating Expenditures” at the 
bottom of the screen, indicating that errors were detected during an 
expenditure allocation. 
 
 
 
Fig. 40 

  
 
This error will often arise when there is a problem with an allotype for a 
record in the allo-look-up table.  The probable cause is that some portion of 
that record in the allo-look-up table has been keyed incorrectly.  As with 
the state data allocation error discussed on the previous page, this problem 



Crosswalk User Guide 
      

72 

can be easily and quickly resolved since the record(s) in error are provided in 
the error message box.     
 
Allocation Status 
 
Figure 41 (below) is the Allocation Status box that appears at the end of 
the translation process when no allocation errors have occurred, indicating 
that the allocation process is complete.  Figure 42 is the Allocation Status 
box that is displayed when allocation errors have occurred. 
 

Fig. 41          

    
 Fig. 42 
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Appendix A 

Frequently Asked Questions 
 

General 
 

1) How can I determine if my state is a candidate for the Crosswalk 
program? 

 
Answer: 
 
This could be a tough question to answer.  First, you must ask yourself 
if there is really a need to change the way you produce your NPEFS 
report.  If the method you use now is convenient, and produces the 
report in an accurate and timely fashion, there is no need to switch to 
another method.  If you were a state that is constantly changing your 
reporting instrument or your state’s chart of accounts, you would not 
be a good candidate for this program.  If you would like to discuss the 
pros and cons of the Crosswalk program with an NPEFS staff member 
we will gladly provide assistance to help you decide. 

  
2) How do I become a Crosswalk state?   

 
Answer:   
 
Simply contact the NPEFS staff and tell them you want to become a 
Crosswalk state. 
 
E-mail:  govs.npefs@census.gov 
Toll Free:  800-437-4196 

 
3) When I become a Crosswalk state, can I use the Crosswalk program      

that same fiscal year to report data for the NPEFS survey? 
 

Answer: 
 
Usually the answer is no.   We cannot guarantee that we can develop, 
and test your state’s software that quickly.  We must develop, among 
other things, a translation table that “translates” each of the 
applicable records within your state’s chart of accounts to a matching 
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NPEFS category on our survey form.  That usually takes months to 
complete. 

  
       

4) What maintenance is involved, if any, to prepare for the next fiscal 
years processing? 

 
Answer:   

  
Your state’s translation table must be updated to add (or delete) any 
changes in records in your state’s chart of accounts.  Either the 
respondent or a Crosswalk staff member can complete this task. 

 
5) What are the advantages to becoming a Crosswalk state? 

 
Answer: 

a) The Crosswalk program promotes timeliness, accuracy, 
consistency, and comparability of data across functions 
and among states. 

b) A specific contact person is available to resolve any 
data placement uncertainties. 

c) Editing tools and reports are built in the Crosswalk 
software to detect data anomalies. 

 
Troubleshooting 
 

1) The software is translating my data, it processes the revenue 
translations (I know this because the revenues stopped blinking and 
expenditures started blinking) but during the expenditure translation 
portion I receive an error and the translation stopped.  The error reads, 
“Error 94, invalid use of Null.”  I clicked OK and the software just shuts 
down.  What is “Error 94”?  How do I fix it and get started again? 

 
Answer: 
 
“Error 94, invalid use of null” simply means that there is at least one 
blank cell located in either the expenditure input file or the expenditure 
portion of the translation table.  Notice that the error didn’t occur 
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during the revenue portion of the translation, indicating that no problems 
existed in the revenue input file or translation table.     
 
You can fix this problem by finding out where these blank cells are 
located.  Open the “State Data” report for expenditures.  Carefully 
check each field as you review the entire file until you find a blank.  It is 
more likely that the blank is located in the original state data file than in 
the translation table.  If you locate the blank, take notice of your 
position.  If, for example, you find a blank field in the 56th record on the 
second page, remember that all the state data has already been loaded 
into the Crosswalk softer and that you will have to go back to this same 
position in the original input file, fix the blank field, and reload your 
state’s data.  The best solution:  
 

1) Go back to your original input file and fill in the blank cell(s) 
with the appropriate data.  

2) Delete the data that has already been loaded (Delete State 
Data) 

3) Reload the data (Load Data) 
4) Re-translate the newly loaded data (Translate Data)   

 
If you locate blank cells in the translation table, please contact the 
Crosswalk staff and we will assist you. 

 
 

2) When I load my data file, I get a message box stating, “State Revenue 
(or Expenditure) Data is Already Loaded – Do you want to load additional 
items?”  What does this mean? 

 
Answer: 
 
The Crosswalk software was developed to accommodate the loading of 
multiple files from multiple sources.  If you have a single file to load and 
you have loaded it and you try to load the same file again, this is simply a 
reminder that you have already loaded this exact file.  In this case, you 
should obviously select No as you don’t want to load the same file twice.    
If you have multiple files to load and you know you haven’t loaded them 
all, select Yes as you do want to load additional items. 
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3) Does it matter if I load revenues or expenditures first?   

 
Answer: 
 
No.  You can load any combination of files in any order you wish.  Please 
be aware, however, of the type of data you are loading.  It is very 
possible, for example, to load revenue files onto an expenditure load 
screen (and vice versa) if you are not careful.  Always look at the upper 
title bar of the crosswalk software to determine the type of data your 
current Crosswalk screen accepts (revenues or expenditures). 
 
  
4) Can anyone install the Crosswalk software in my office? 

 
Answer:   
 
If your computer is operated under Windows2000, WindowsNT, or 
WindowsXP, you must have “administrative rights” to perform installation 
of the Crosswalk software.  Since many, if not all of us, are using one of 
these operating systems, you will probably need a LAN staff person to 
install this software. 
  
5) I’m loading my data file into the Crosswalk software using an Excel 
spreadsheet.  I use the “Browse” box to locate and select my file.  I then 
get an “Enter Worksheet Name” prompt box that defaults to “Sheet1.”  
What does “Sheet1” mean?  If I click “OK” everything seems to load just 
fine. 

  
Answer: 
 
Excel files usually have multiple spreadsheets within one file (workbook) 
so you must tell the Crosswalk software the name of the spreadsheet you 
are loading (usually different from the name of the Excel file you are 
loading).  The default name of the first Worksheet in an Excel File is 
always “Sheet1” but if you have named your spreadsheet something other 
than “Sheet1,” you must type in the correct name of the spreadsheet in 
this prompt box or your spreadsheet will not load.   
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6) I read in the Crosswalk User Guide that the Crosswalk software uses 
Microsoft Access as its underlying database in the Crosswalk 
application.  We don’t use Access in our office.  Can I still use the 
Crosswalk software? 

 
Answer: 
 
Yes.  It doesn’t matter whether or not you have Access loaded on your PC 
because, during the software installation process, Microsoft Data Access 
Components are installed onto your PC allowing you full access.   
 
 
7) As my data was translating,  I received an error that read, “Overflow 

Error on record____field____?”  All I could do was click OK within 
the error box and the software immediately shut down.  What is this 
error and how can I fix it?  

 
Answer: 
 
This error is letting you know that the Crosswalk software detected a 
formatting error at the record and field position that was indicated in 
the error message.  This error message appears whenever you append 
data items to an existing Excel Spreadsheet (even if the formatting 
appears to be fine).  Usually, the only way to fix this problem is to make a 
new spreadsheet of these records.  Importing this spreadsheet into 
Access can also usually fix any of these formatting problems.  Please note 
that all data records prior to the record number stated in the error 
message did load correctly.  Keep this in mind!  We have safeguards in 
the software to prevent you from loading duplicate records.  However, if 
you are unsure of what data you have loaded and what data you have not 
loaded, it is best to delete all state data for that data type (revenues or 
expenditures) and load the data again.     
 
 
8) I know that I correctly adjusted the unmatched data records in the 
translation table, however, I still get the same unmatched data record 
error message.  What else can I do? 
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Answer: 
 
There is a good chance these records are being picked up in another 
aggregated total.  Notice that for each record we have ranges in the 
translation table for fund, function, and object.  Look closely at the 
record you are adding or adjusting to confirm this record isn’t included 
within the range of another record.  In all likelihood, this is your problem.   
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APPENDIX B 
CROSSWALK ITEM CODES AND DESCRIPTIONS 

ITEMCODE Descriptions   ITEMCODE Descriptions 

            REVENUE   261 Student Supp Svcs, other 

R11 Property tax   262 Instruction Supp Svcs, other  

R12 Non-property Tax   263 Gen Admin Supp Svcs, other 

R13 Other Local Government Units-Property Tax   264 Sch Admin Supp Svcs, other 

R14 Other Local Govern Units-Non-property Tax   265 Oper & Maint Supp Svcs, other 

R15 Tuition from Individuals   266 Stu Transp Supp Svcs, other 

R16 Tuition from Other LEAs within the State   267 Other Supp Svcs, Other 

R17 Transportation Fees from Individuals   26Y TOTAL SUPP SVCS, OTHER 

R18 Transport Fees from Other LEAs within the State   2Y1 TOTAL STU SUPP SVCS  

R19 Earnings on Investment   2Y2 TOTAL INSTRUCTION SUPP SVCS  

R1A Food Service (excluding Federal reimbursement)   2Y3 TOTAL GEN ADMIN SUPP SVCS 

R1B District Activities   2Y4 TOTAL SCH ADMIN SUPP SVCS  

R1C Other Revenue from Local Sources   2Y5 TOTAL OPER & MAIN SUPP SVCS  

R1D Textbook Revenues   2Y6 TOTAL STU & TRANSP SUPP SVCS  

R1E Summer School Revenues   2Y7 TOTAL OTHER SUPP SVCS 

R1Y LOCAL SOURCES OF REVENUE SUBTOTAL   2YY TOTAL – TOTAL SUPP SVCS 

R2 Revenue from Intermediate Sources   311 Food Svcs, salaries 

R3 Revenue from State Sources   312 Enterprise Operations, salaries 

R41 Grants-in-Aid Direct from the Fed Govt    321 Food Svcs, employee benefits 

R42 Grants-in-Aid from the Fed Govt thru the State   322 Enterprise Operations, empl bene 

R43 Grants-in-Aid fr Fed Govt thru Other Inter Agency   331 Food Svcs, purch svcs. 

R44 Other Revenue from Fed Sources   332 Enterprise Operations, purch svcs. 

R4Y FEDERAL SOURCES OF REVENUE SUBTOTAL   341 Food Svcs, supplies 

R5 Other Sources of Revenue   342 Enterprise Operations, supplies 

R6Y TOTAL REVENUE FROM ALL SOURCES    351 Food Svcs, property 

ZZZZZZZZ * Excluded from Survey   352 Enterprise Operations, property 

           EXPENDITURE   361 Food Svcs, other 

11 Instruction, salaries   362 Enterprise Operations, other 

11a Salaries paid to teachers in reg. educ. prog   3Y1 TOTAL FOOD SERVICE 

11b Salaries paid to special education teachers   3Y2 TOTAL ENTERPRISE OPERATIONS 

11c Salaries paid to vocational education teachers   411 Dir Supp - Textbooks for Pub Sch Children 

11d Salaries paid to teachers in other programs   412 Dir Supp - Textbooks, Property 
2 Textbook exp. for classroom instruction   421 Dir Supp - Transport for Pub Sch Children 

11 Instruction, salaries   422 Dir Supp - Transport, Property 

12 Instruction, employee benefits   431 Dir Supp - Employee Benefits 

13 Instruction, purchased services   432 Dir Supp - Employee Benefits, Property 

14 Tuition payments outside the state and to private   44 Dir Supp - Private School Students 

15 Tuit/voucher paymts to other LEAs charter within   451 Dir Supp - Other - Pub Sch Students 

16 Instruction, supplies   452 Dir Supp - Other - Pub Sch Students, Prop  

17 Instruction, property   4Y1 TOTAL DIRECT PROGRAM SUPPORT 

18 Instruction, other   5Y CURRENT EXPENDITURES  



1Y TOTAL INSTRUCTION EXPENDITURES    61 FACS  Non-Property Expenditures 

211 Student Supp Svcs, salaries   62 FACS Property Expenditures 

212 Instruction Supp Svcs, salaries   63 FACS Equipment 

213 General Admin Supp Svcs, salaries   711 Debt Service, Interest 

214 Sch Admin Supp Svcs, salaries   712 Debt Service, Principal 

215 Oper & Maint Supp Svcs, salaries   71Y TOTAL OTHER USES  

216 Stu Transp Supp Svcs, salaries   81 Community Services-Non-property 

217 Other Supp Svcs, salaries    82 Community Services-property 

21Y TOTAL SUPP SVCS SALARIES    911 Direct Cost – Non-Pub Sch Prog 

221 Student Supp Svcs, employee benefits   912 Direct Cost – Adult Education 

222 Instruction Supp Svcs, employee benefits   913 Direct Cost – Community Colleges 

223 Gen Admin Supp Svcs, employee benefits   914 Direct Cost – Other 

224 Sch Admin Supp Svcs, employee benefits   91Y DIRECT COST PROG SUBTOTAL 

225 Oper & Main Supp Svcs, employee benefits   92Y DIRECT COST PROG – PROPERTY 

226 Stu Transp Supp Svcs, employee benefits   AY PROPERTY TOTAL 

227 Other Supp  Svcs, employee benefits   BY TOTAL EXPENDI FOR EDUCATION 

22Y TOTAL SUPP SVCS, EMPLOYEE BENEFITS   C1 Tuition paid by individuals 

231 Student Supp Svcs, purch svcs.   C2 Transportation fees paid by individ 

232 Instruction Supp Svcs, purch svcs.   C3 Title I Expenditures 

232 Gen Admin Supp Svcs, purch svcs.   C4 Title I carryover expenditures 

234 Sch Admin Supp Svcs, purch svcs.   C5 Title V, Part A expenditures 

235 Oper & Maint Supp Svcs, purch svcs.   C6 Title V, Part A carryover expend 

236 Stu Transp Supp Svcs, purch svcs.   C7 Food service revenues 

237 Other Supp Svcs, purch svcs.   C8 District activities revenues 

23Y TOTAL SUPP SVCS, PURCH SVCS    C9 Textbook revenue exclusions 

241 Student Supp Svcs, supplies   CA Summer school rev exclusions 

242 Instruction Supp Svcs, supplies   CY TOTAL EXCLUSIONS  

243 Gen Admin Supp Svcs, supplies   DY NET CURRENT EXPENDITURE 

244 Sch Admin Supp Svcs, supplies   E1 ADA – STATE DEFINITION 

245 Oper & Maint Supp Svcs, supplies   E2 ADA – NCES DEFINITION 

246 Stu Transp Supp Svcs, supplies   F1 SPPE – USING STATE DEF 

247 Other Supp Svcs, supplies   F2 SPPE – USING NCES DEF 

24Y TOTAL SUPP SVCS, SUPPLIES      

251 Student Supp Svcs, property     

252 Instruction Supp Svcs, property     

253 Gen Admin Supp Svcs, property     

254 Sch Admin Supp Svcs, property     

255 Oper & Maint. Supp. Svcs, property     

256 Stu Transp Supp. Svcs, property     

257 Other Supp Svcs, property     

25Y TOTAL SUPP SVCS, PROPERTY     
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Appendix C 

 
SPECIAL CROSSWALK H2R2 FUNCTION CODES 

 
 

I. Revenue from Local Sources 
 

n.  Summer School Revenue       1360 
 
 

IV. Direct Program Support 
 

a) Textbooks for Public School Children    7100 
b) Transportation for Public School Children   7200 
c) Employee Benefits for Public School Employees  7300 
d) Direct Program Support for Private Sch Students  7400 
e) Direct Program Support for Public School Students  7500 
  
 

IX. Direct Cost Programs 
 

a) Non-Public School Programs     3600 
b) Adult Education       3400 
c) Community College        3700 
d) Other (Specify)       3800 
 
 

XII. Exclusions from Current Expenditures for State Per Pupil 
Expenditures (SPPE) 

 
Title I expenditures       8100 
Title I Carryover expenditures     8200 
Title V, Part A expenditures      8300  
Title V, Part A Carryover expenditures    8400 
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Appendix D 
 

CROSSWALK ITEM CODES AND H2R2 
FUNCTION/OBJECT CODES FOR SPECIAL EXHIBIT 

ITEMS 
 
 
ITEMCODE DESC BH2R2FUNCT EH2R2FUNCT BH2R2OBJ EH2R2OBJ 
11a Salaries paid to teachers in 

regular ed 
1001 1001 111 113 

11b Salaries paid to special 
education teachers 

1002 1002 111 113 

11c Salaries paid to vocational 
education teachers 

1003 1003 111 113 

11d Salaries paid to teachers in 
other programs 

1004 1004 111 113 

2 Textbook expenditures for 
classroom instruction 

1005 1005 640 640 
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Appendix E 
 

State Fund Legend for Special Exhibit Items 
 
FUND   DESCRIPTION 
   RE  Salaries paid to teachers in regular education programs 
   SE  Salaries paid to special education teachers 
   VE    Salaries paid to vocational education teachers 
   OE  Salaries paid to teachers in other programs 
   TB  Textbook expenditures for classroom instruction 
 


